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The following topics have been exported from the TrialDirector 6 Help System to enable 
easy printing. To access the most current information from the full Help system, open the 
Help menu in TrialDirector. 
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Creating a New Case 
To import items into TrialDirector, first create a case into which you'll load images, transcripts and other 
items. 

To create a new case 

1. Select Create a New Case from the File menu or click the New Case tool on the Toolbar. 

 

2. The default case path is automatically selected as the destination location for the case files. To 
change the case path, click Browse and navigate to the location where you want the case stored. 
You may also wish to add multiple case paths. If so, click Edit to add more than one path. Long 
filenames are supported, so you are not limited to eight character filenames. 

3. Click Next. 

4. Type the name of the new case in the Case Description field. You can also enter a Matter Number 
and Notes, if desired. 
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• Long filename naming conventions are supported. You are not limited to eight character 
names. 

 

5. Select Use Case description for directory name if you want the directory name to be the same as 
the Case Description. If Use Case description for directory name is not selected, TrialDirector will 
name the case folder using a number scheme, i.e., CASE0005. 

6. Click Next. 

7. You may want to set up case security. If so, select the Enable Case Access Security checkbox 
and enter an Administrator User ID and Password. To further secure case data, select the Enable 
Case Encryption checkbox. You may also choose to skip case security. 

8. Click Create. 

The new case is created. Documents, Multimedia and Transcripts folders and a Trial Exhibits Workbook are 
displayed. 

To view the Matter number and notes you associated with the case when you created it, right-click on the 
case name in the Case Explorer and select Properties. 
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Opening an Existing Case 
Depending on the options selected in the Options settings, when you start TrialDirector, you will see either 
the last case opened (the default setting) or a list of the cases stored in the last accessed case path. (See 
Document Manager Options to learn how to revise this setting.) 

To open an existing TrialDirector case 

1. Select Open Case from the File menu or click the Open Case tool button on the Toolbar. 

2. Use the drop-down list to select the case you wish to open.  
• If you do not see the case in the selection list, click the Browse button to select a different 

case path. 
3. Once you select a case, click Open. 
4. If you are opening a case that is secured with a password, you must enter the appropriate 

Username and Password in the Secure Case Access Login dialog. Then click Login. If you don't 
know the login information, click Cancel to return to the case list or contact your administrator.  

• You may be prompted to backup the case. If so, click Yes to backup the files. Click No to 
skip the backup and open the case. 

TrialDirector opens to the case you selected, displaying the Case Explorer, Workbooks Explorer and the first 
image listed in the Documents folder of the Case Explorer.
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Loading Items into Your Case 

A TrialDirector case may contain a variety of items comprising what may become or already are identified 
as exhibits in your case. These might include images of documents, deposition and trial transcripts 
(including, possibly, digitized and synchronized video), multimedia files (such as audio recordings or 
surveillance videos), and native files (Word, Excel, PowerPoint, Adobe PDF files, to name a few). See 
Supported File Formats for a complete list. 

You may load documents or transcripts using drag-and-drop or you may use menus and dialogs to walk 
through the process. 

Loading Documents 

There are a few methods for adding items to your case, depending on the type of item and the source of 
the files. 

• Did you receive a "load file" (typically with an .OLL, .DII or .LFP extension)? Then you'll use the 
Batch Import Files loading technique. 

• Do you have a group of images or native files but no batch loading file? Then you'll use the 
Manual Selection Dialog to load those items. 

• You may need to scan and load images directly into TrialDirector using a Twain-compliant 
scanner. Any of these approaches can be used when you're working in the Case Explorer, 
Document Manager or Coding modules of TrialDirector. 

Loading Transcripts 

Loading transcripts must be done from the Transcript Manager. You might have just a transcript file (in 
ASCII or Amicus or PTF -- Portable Transcript Format). You may also be have received a video file to go 
along with the transcript. If so, you'll want to have the transcript and the video synchronized (if they've not 
already gone through the synchronization process). If they have been synchronized, you'll load a CMS 
(Compound Media Storage) file, which lets you load that transcript and its associated media and 
synchronization information into your case.  

  

Loading Documents Loading Transcripts 
Loading Items Using the Manual Selection 
Dialog 

Loading Transcripts - Amicus or ASCII 
Format 

Loading Items Using Batch Import Files 

Loading Transcripts - Portable Transcript 
(PTF) Format 

Loading Items Using a Scanner 

Loading Digitized and Synchronized 
Transcripts 

Loading Items Using Drag-and-Drop   
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Loading Items Using the Manual  
Selection Dialog 
Use the Manual Selection Dialog to load images, native and multimedia files when you have not been 
provided with a batch load file. 

To Load Documents Without a Batch Load File 

 

Note: It is always a good idea to make a backup of your case before you load a large 
number of items, just in case something goes awry.   

1. From the Case Explorer, Document Manager or Coding views, open the Document menu. 

2. Select Import New Item(s) from... 

3. Choose Manual Selection Dialog from the flyout menu. The Windows Select Items window opens. 

• In the Windows Select Items dialog, select the View tool to choose how the items will be 
displayed. Note that you can view thumbnails of the items you're loading, as well as a List or 
Details. 

4. Navigate to the location of the files you want to add to TrialDirector. 

5. Select the files you want to load and click Open. 

• Select a single file by double-clicking on the filename. 

• To select several non-adjacent files for loading, hold down CTRL and click on each file. 

• To select a range of files, hold down SHIFT and click the first and last file in the range. 

6. In the window that opens ("Manually Select New Items for Import..."), you will make decisions about 
how to name the item(s) being loaded.  
  

 

Note: It's very important that the ID numbers you establish here are unique and do not already 
exist in your TrialDirector case. If Item ID numbers are duplicated, TrialDirector will attempt to 
overwrite the existing items with the new items you are loading. 
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7. Once you make the necessary changes and verify the appearance of the number in the Page ID 
Example window, click OK. The new items are now accessible from the Case Explorer, the 
Document Manager and the Coding tabs. They are also able to be shown in Presentation mode.  
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Loading Items Using Batch Import Files 
A batch import (or batch load) file automates the process of adding a group of items to a case, avoiding the 
slow, tedious task of adding items one-at-a-time. Using a defined format, a batch load file typically contains 
information about the filenames, the location of the files and the types of files. 

The load file most identified with TrialDirector is called an Object Load List (*.oll). Object load lists can be 
manually created using a text editor. TrialDirector also accepts several types of batch load files produced by 
other programs. Batch load files currently supported by TrialDirector are: 

• TrialDirector database files (*.mdb) (includes annotation references, if any) 

• CT Summation iBlaze® Document Image Information files (*.dii) 

• IPRO load files (*.lfp) 

• DocuLex™ Volume Contents files (*.txt) 

• DocuLex™ Database Files (*.dbf) 

• Opticon v2.0 ImageBase Load Files (*.opt) 

• Generic Image Load files (*.log) 

TrialDirector also offers a utility called FileBridge, located in the Tools menu, that lets you convert certain 
types of batch load files into an .oll file or other compatible format. 

 

Note: If you are adding items from a volume that you have exported from a TrialDirector case, use the 
database file (*.mdb) rather than the object load list (*.oll). The *.mdb file contains references to any 
annotations made on the items; the *.oll file does not contain that information. 

  

To Load Documents Using a Batch Load File 

 

Note: It is always a good idea to make a backup of your case before you load a large 
amount of items, just in case something goes wrong with the load process.   

1. From the Case Explorer, Document Manager or Coding views, open the Document menu. 

2. Select Import New Item(s) from... 

3. Choose Batch Import File from the flyout menu. The following dialog appears. 
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4. In the first field -- Select the Batch Import file format -- select the type of batch file you are 
importing. By default, TrialDirector selects an .oll file but click on the drop-down arrow to select from 
a list of compatible file types. 

5. In the second field -- Select the Batch Import path and filename -- type the path and filename of 
the batch file you are using (for example, C:\images\load.oll) or click Browse to locate the file.  

6. Click Next. 

 
  

7. If all of the items you are importing need to be rotated, select the number of degrees (clockwise) the 
images should be rotated. If only a few of the items require rotation, it is better to perform the 
rotation using the rotation tools on the main TrialDirector toolbar. 

8. Click Next 

9. Click Import. The import processing time depends on the number of items you are importing. 
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10. When the import is complete, click OK. 

If there were no errors during the import process, the imported items will now appear in the Case Explorer 
and Document Manager. Because the load file contained the Doc ID and file type information, the items are 
displayed in the appropriate area of the Case Explorer.  
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Loading Items Using a Scanner 
You can scan documents using a TWAIN-compliant scanner and import the images into your case. If you 
don't know whether your scanner is TWAIN-compliant, check the scanner documentation or search the 
Internet for "twain-compliant scanner". 

Loading Documents Using a Scanner 

1. From the Case Explorer, Document Manager or Coding views, open the Document menu. 

2. Select Import New Item(s) from... 

3. Choose Capture Device (Twain Scanner).  The Import window opens. 
 

Note: If the Title Bar of the Import window says, "No Twain scanner sources are available," you 
need to install a scanner. Consult the scanner user manual for more information. 
 

 

4. On the Capture Settings tab, set the following: 

Option Description 

Select Destination 
Folder 

Select the path where you want to store the images. The current 
case path plus \Capture is the default storage location. To modify 
the storage location, click the Browse button. 

Each image filename will consist of the image id and an extension, 
depending on whether you're scanning a black and white 
document or a color photo or document. These selections are 
usually made on your scanner. 

TrialDirector retains this path as the default path so that the next 
time you scan, you don't have to re-set the path. 
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Current Document 
ID 

Displays the Document ID for the document currently being 
scanned. The Document ID will be the same as the Image ID of the 
first page of the document. It is filled in automatically after the 
Image ID has been set and the New Doc or Scan button is clicked. 

Next Image ID Assign an Image ID (up to eight characters) to the first page being 
scanned. When scanning multiple pages of the same document, 
the Image ID increments automatically, although you can manually 
edit it at any time. 

Page # Indicates the physical page number of the image you are scanning. 
When scanning multiple pages to the same document, the page 
number increments automatically. 

5. On the Image Settings tab, set the following: 

Option Description 

Use Manual 
Scanner Controls 

Check this option to use the software associated with your 
scanner, which may allow you more detailed control over the scan 
process 

Note: There is variation in compliance with the Twain 
interface requirements among various scanner manufacturers. 
These variations may affect or disable the functionality of some 
scanning features. 

Use Automatic 
Document Feed 
(ADF) 

Check this option to set the scanner to use automatic document 
feed or to allow batch scanning. 

Deskew B&W Text Check this option to deskew black and white document (text) 
images as they are scanned. 

Duplex Scan For printers with duplex (double-sided) scanning, check this option 
to capture both sides of the document being scanned. 

Color Depth Choose a file format and color palette: black & white (1 bit per pixel, 
.TIF image), 256 color (8 bit per pixel, .BMP image) or true color (24 
bit per pixel, .JPG image). 

Resolution (DPI) 
Allows you to set the resolution (measured in dots-per-inch) of the 
scanned image. Typically, the higher the resolution, the larger the 
resulting file size but the clearer the image. Large file sizes will take 
longer to load than smaller file sizes. The general recommendation 
for black-and-white TIF images is 300 dpi. For color JPGs, you may 
want to reduce the resolution to 100 or 200 to make the file size 
smaller. The challenge is to choose settings that create an image 
that loads quickly in court without sacrificing the quality of the 
image. If you aren't sure, run a test scan first. 

Paper Size Set the paper size for the scanned items. Legal (8-1/2 x 14) is the 
largest size. 
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6. You have the option to include basic coded information during the scanning process. Open the 
Coding Fields tab and enter some, none or all of the following information for each scanned 
document: 

Option Description 

Title Title of the document 

Author Author or authors 

Recipient Recipients 

Date Document date 

Source Source of the document 

Type Document type, e.g., letter, handwritten note, response, notice, 
pleading. 

Clear Coding History Clear the entries in any of the above listed fields 

Clear fields when 
starting new document 

Select this check box to automatically clear the fields when 
scanning a new document 

7. At the bottom of the main Capture window, select the check box if you want to review the 
documents you scanned before adding them to your case. (Once you've reviewed the documents, 
click Add to Case.) 

8. Click Scan to begin scanning a document. Buttons are provided for the following actions: 

Option Description 

New Document Select each time you want to scan a new document during the 
current scanning session 

Rescan Re-scans the current document 

Delete Deletes the current scan, does not save the image 

Add to Case Saves scanned image(s) to current case 

Close Closes the Import New Items from Capture Device window 

9.  Click Add to Case.  
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Loading Items Using Drag-and-Drop 
Any item can be added to your case in TrialDirector using the drag-and-drop technique. Just make sure 
you're in the appropriate area of the program. When you want to add documents (including batch load files), 
then drag the files onto the Case Library or Document Manager view. If you want to add a transcript or DVT 
(using CMS files), make sure the Transcript Manager is the active window on your TrialDirector desktop. 

To Load Items Using Drag-and-Drop 

1. With the current case open in TrialDirector, open Microsoft Explorer (or My Computer). Size and 
position the windows on your desktop so you can work with both simultaneously . 

2. To load documents or batch load files, make sure either the Document Manager or the Case Library 
tab is the active window. To load transcripts or DVTs, make sure the Transcript Manager is the 
active window. 

3. Select one or more items in Windows Explorer (or My Computer) to add to the case.  

4. Hold the left mouse button down and drag the items over to TrialDirector. When you release the 
mouse button, a dialog box will open prompting you to fill in information. See Loading Items into 
Your Case for help with these dialog boxes. 
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Loading Transcripts -  
Amicus or ASCII Format 
TrialDirector can work with transcripts in ASCII or Amicus format. The process to load each format is very 
similar. The difference is in the text extension for each file. ASCII transcript files may end in .ASC or .TXT or 
.V# (for volume number). Amicus transcript files end in .AMI. 

To Load Transcripts - Amicus or ASCII Format 

1. In the Transcript Manager, open the Transcripts menu, select Import Transcript(s) from..., and 
choose either AMICUS Transcript (*ami) or ASCII Transcript (*.txt) from the flyout menu. 

 
  

2. Click Browse and navigate to the location of the transcript file on your drive or network.  Select the 
file and click Open. The path and filename should now appear under Select a Transcript. Click 
Next. 

3. TrialDirector attempts to fill in identifying field information based on the transcript file. Usually, the 
Deposition Information checkbox is automatically. If the Deposition Information is blank or 
incorrect, you may edit the information. To verify the information against the transcript, click Edit. 

• The transcript you're loading may not be a deposition transcript but may have been 
prepared for a hearing or trial. In that case, click the Other checkbox and fill in a short 
description in the adjacent box. The description you enter will appear in the Transcript 
Explorer. 

4. Click Next to continue. 

• TrialDirector automatically tries to determine the page and line information for the selected 
transcript, but it is important for you to verify the information so that page:line citations are 
accurate. Click Edit to confirm and, if necessary, adjust the starting page. Note that the first 
page will be the first page on which text with line numbers appears, not necessarily the title 
page of the transcript. 
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5. Click Import to begin importing the transcript. If any of the deposition information is missing, the 
Import button will not be available. In that case, click Back twice to return to the deposition 
information page and enter the appropriate information. 

 

  

6. When the import is complete, click OK to return to the Transcript Manager or click Again to load 
another transcript. 

• If the check box next to Automatically index new transcript(s) is checked, the transcript 
will be indexed before it is added to the Transcript Explorer. If the check box is not checked, 
you can index transcripts later.  
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Loading Transcripts -  
Portable Transcript (PTF) Format 
TrialDirector can work with transcripts in Portable Transcript Format (.ptf), a format produced by LiveNote®. 

TrialDirector includes a utility to load PTF transcripts singly or in batches. If the PTF transcript has an 

associated video, however, you will need to use TimeCoder to associate the video with the transcript. 

 To Load PTF Transcripts 

1. In the Transcript Manager, open the Tools menu, select Batch PTF Import Tool.... 

 

2. When the Import Utility dialog opens, select the case to which the files will be added, then click 
Next. 

3. Enter or browse to the location where the desired PTF files are located. Click Next. 

4. A list of all PTF files in the selected folder is displayed. Select the transcripts to be loaded from the 
list and click Next. 

5. Click Import. When the import is completed, click OK to exit the import dialog.  
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Loading Synchronized Transcripts 
TrialDirector lets you display and present synchronized digital transcripts, a powerful method to engage 
jurors. A synchronized transcript is a combination of (1) the transcript of a proceeding, such as a 
deposition, hearing or trial; (2) the corresponding multimedia file(s), such as video of the testifying witness; 
and (3) a *.CMS (Compound Media Storage) file, which correlates each line of the transcript to the 
appropriate line in the video.  

If you have a transcript and a video, then they can be converted into a synchronized transcript, a process 
usually referred to as "timecoding" or "synchronizing". This can be done by inData, by an authorized 
inMotionTM DVT Service Bureau, or by you or someone in your office using the TimeCoder module in 
TrialDirector or TimeCoder Pro, a separate product sold by inData. 

You can load a single synchronized transcript, multiple transcripts (using multiple CMS files) or 
DepoView® transcripts. 

To Load a Single Synchronized Transcript 

1. Copy the multimedia files to a location on your network, laptop or hard drive. 

2. In Transcript Manager, open the Transcripts menu, select Import Transcript(s) from..., and 
select Synchronized Transcripts. 

3. To import a single synchronized transcript, select Specific Compound Media Storage (*.cms) file 
and click Next. (To import multiple files within a single folder, click here for instructions.)  
 

 
  

http://www.indatacorp.com/Products/Video/timeCoderPro.aspx�
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4. Click the Browse button to navigate to the location of the *.CMS file you wish to load. Click to 
select the *.CMS file then click OK to close the Browse dialog.  

 

5. Choose Copy all multimedia files (recommended). 

6. Click Browse, navigate to the location of multimedia files that are associated with the *.CMS file 
you loaded in the previous step, then click OK to close the Browse dialog. The selected file 
appears in the Select a file to import... window. 
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7. Click Next. If you have no changes to make to any of the selections you made in steps 3-6, click 
Import. 

 

8. The synchronized transcript is loaded into your case, showing the progress bar as the import is 
completed. Click OK to close the dialog. 

• If the check box next to Automatically index new transcript(s) is checked, the transcript 
will be indexed before it is added to the Transcript Explorer. Click OK to close the Index 
Transcripts dialog. 
  

• If the check box is not checked, you can index transcripts later. Indexing transcripts is 
important. See Indexing Transcripts for more information. 

If you receive a message stating that the multimedia cannot be located, click here for instructions. 

To Load Multiple Synchronized Transcripts 

1. Copy the multimedia file(s) to a location on your network, laptop or hard drive. 

2. In Transcript Manager, open the Transcripts menu, select Import Transcript(s) from..., and 
select Synchronized Transcripts. 

3. To import a single synchronized transcript, select Multiple files within a specified folder and 
click Next. (To import a single file, click here for instructions.)  
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4. Click the Browse button to navigate to the location of the multiple *.CMS files you wish to load. 
Click to select the folder then click OK to close the Browse dialog.  
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5. The transcripts whose *.CMS files are contained in the selected folder appear. 

 
  

• Click Select All to check all transcripts in the folder. 

• Click Clear All to deselect all transcripts, then click in the checkbox adjacent to the 
transcripts you wish to load. 

6. Click Next. Choose Copy all multimedia files (recommended).   

7. Click Browse, navigate to the location of multimedia files that are associated with the *.CMS files 
you loaded in the previous step, then click OK to close the Browse dialog. The folder containing 
the multimedia files appears in the Select a target multimedia folder box. 
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8. Click Next. If you have no changes to make to any of the selections you made in steps 3-7, click 
Import. 
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9. The synchronized transcripts are loaded into your case, showing the progress bar as the import is 
completed. Click OK to close the dialog. 

 

• If the check box next to Automatically index new transcript(s) is checked, the transcript 
will be indexed before it is added to the Transcript Explorer. Click OK to close the Index 
Transcripts dialog. 
  

• If the check box is not checked, you can index transcripts later. Indexing transcripts is 
important. See Indexing Transcripts for more information. 

If you receive a message stating that the multimedia cannot be located, click here for instructions. 
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To Load DepoView Transcripts 

1. With a DepoView disc in the CD/DVD drive of your computer, open the Transcripts menu in 
Transcript Manager, select Import Transcripts from..., and choose Synchronized Transcripts. 
The deposition description appears under Physical DepoView CD/DVD disc(s). Click Next.  

 
2. Choose Copy all multimedia files (recommended), and then click Browse and navigate to the 

location where you want to copy the video files on your computer.  
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3. Click Next. If you have no changes to make to any of the selections you made in steps 1-2, click 
Import. 

 

4. The media files on the CD/DVD are copied to the location indicated in step 2 and the 
synchronized transcript is loaded into your case, showing the progress bar as the import is 
completed. (This process may take some time to complete if it is copying large files to your 
system.) Click OK to close the import confirmation dialog. 

 

• If the check box next to Automatically index new transcript(s) is checked, the transcript 
will be indexed before it is added to the Transcript Explorer. Click OK to close the Index 



TrialDirector 6 Help - Working with Cases 

 Copyright ©2010 inData Corporation. All Rights Reserved. 27 

Transcripts dialog. 
  

• If the check box is not checked, you can index transcripts later. Indexing transcripts is 
important. See Indexing Transcripts for more information. 

5. If you receive a message stating that the multimedia cannot be located, click here for instructions. 

Resolving Multimedia File Location Message 

You may see the following message when you click Import. If so, click Browse and navigate to the 
correct location for the multimedia file(s). You may have to attach an external drive (if that is where you 
store your multimedia files) or you may have to copy the multimedia file(s) to your system from a DVD. 
Once you've located the correct file, click OK and the import proceeds. 
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Loading inMotion DVT Media Transcripts 
Loading inMotion DVT Media Transcripts follows the identical procedures as those when loading Digitized 
and Synchronized Transcripts, except you select inMotion DVT Media from the Import Transcript(s) from... 
dialog. See Loading Digitized and Synchronized Transcripts for step-by-step instructions. 
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Remove Items from a Case 
In the Case Explorer or Document Manager, you can easily remove items from your case. 

1. Click on the item(s) to select them. 

2. Select Remove Selected Item(s) from the Documents menu or right-click on any of the selected 
items and choose Remove Selected Item(s). A warning message will appear, requesting that you 
confirm the removal. 

3. Click Yes to remove the item(s) from the case or No to cancel the removal. 

Note: Removing items from a case does not delete the source files from your computer.  
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Viewing Case Items 
When you are working in the Case Library's Case Explorer or in the Document Manager, select an item and 
the Item Viewer displays it on the right side of the screen. You can also view items when you work in the 
Coding module. (Click on the labels below for more information.) 

 

  

  

Depending on the type of item, one or more of the following tabs are available at the top of the Item Viewer: 

• Image tab - Displays any supported image file and enables you to annotate the image. (If the item 
you select is a multimedia file, this becomes the Media tab. If the item you select is a transcript, this 
tab becomes the Transcript tab.) 

• Native tab - Opens the program used to create the file and displays the fully functional version of the 
file within TrialDirector. This tab is unavailable (grayed out) if native viewing is not supported for the 
file type, if the program used to create the file is not installed on your computer, or if the file loaded is 
an image rather than a native file. 

• Text tab - Displays full-text OCR for files that were converted during scanning to searchable full-text 
format. Use this tab to edit the text if needed. 

• Presentation Preview tab (shown in the Case Library and the Document Manager) - Shows what 
any item in your case will look like when it is presented. Drag an item from Case Explorer or 
Document Manager to this tab to preview it and use the presentation tools as needed. During 
presentation, you can use this tab to push changes over to Presentation mode or to make real-time 
changes. See Using Presentation Preview for more information. 
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Note: Pages from PDF files are displayed both as static images on the Image tab (for annotation prior 
to trial), and as fully functional PDF files on the Native tab. Many Advanced PDF Support features are 
available in TrialDirector. 

  

To View Items in Full Screen Mode 

The Item Viewer can be used without the Case Explorer or Document Manager. This is sometimes helpful 
when making redactions or working with annotations. When you want to view items in Full Screen mode, 
simply close the Case Explorer or Document Manager. 

 

To hide the Case Explorer pane 

Click on the Hide Case Explorer tool  on the toolbar or you can click the in the Case Explorer or 
Document Manager View Toolbar.  
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To display the Case Explorer or Document Manager panel again, click once more on the Hide Case 

Explorer tool or click on the Show Explorer tool in the top left corner of the workspace. 

  

 

  

To navigate between items (including individual pages of multi-page documents) when working only with the 
Item Viewer, use the PgUp and PgDn keys on your keyboard.  

Message: Item Is Not Located on Your Computer 

When you select an item to view and the CD or volume containing the item cannot be located on your 
computer or network drive by TrialDirector, TrialDirector displays a message in the Status Bar at the bottom 
of the screen that tells you which volume to load. Mount the correct volume and select the item again.  

You may need to use one of TrialDirector's tools to help with this issue. See Global Path Editor and 
Reconnect Missing File Links for more help. 
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Removing a Case 
To remove a case: 

1. Select Remove Case(s) from the File menu. 

 

Note: When attempting to remove a secure case, the user is prompted to login with a valid 
username/password prior to removal.  Only those users with valid privileges are allowed to remove 
cases.  Secure cases are indicated with a padlock icon, as shown in the image above. 

2. To edit the case path, click [Edit] (see Manage Case Paths). 

3. Select the case or cases you would like to remove.  A special icon indicates that a case cannot be 
removed because it is currently open. If you want to remove the case that is currently open, you 
must open a different case before attempting removal. 

4. After you have selected the case(s) you want to remove, click [Remove]. A warning message will 
appear, allowing you to confirm the removal. 

5. Click [Yes] to remove the case(s) or [No] to cancel the removal. 

 Note:: If you are working in a network environment and another user has a case open, you will not be 
able to remove that case.  
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Creating a Subset Case 
The subset case feature allows you to select specific items and add them to a new case using a batch file. 
You might use this feature if you originally loaded all of your case documents into TrialDirector but now want 
to create a subset case of only those items you will use at trial. 

This advanced feature allows you to: 

 Create a separate case that only contains the exhibits you are going to use in trial. 

 Redefine document boundaries to match the document boundaries defined in a third-party 
database management system.  

 Rename items with generic Item IDs for document production. 

Note: The sample Subset Case Batch File provides an example of how to redefine document 
boundaries, rename items and assign Exhibit and Trial Exhibit Numbers using the subset case feature. 

To Create a Subset Case 

1. Create a batch file listing the items you would like in the subset case, by doing one of the following: 

 Type the subset case batch file manually following the examples in the Sample 
Case Batch File topic. 

 Format a database query result to match the subset case batch file format. 

 Select items and create a batch file of the selected items. 

2. Select Create Subset Case From Batch file... from the Documents menu. 

3. Type a case name in the Enter a Name for the New Case field. 

4. Click Next to continue.   

5. In the Specify The Batch File field, type the full path and filename of the batch file (for example: 
C:\TrialDirector 6\batchfile.txt) or click Browse to locate an existing file. 

6. Click Next to continue.   

7. Select the Include item memos in new case option if you wish to export memos that may be 
associated with the items to be included in the Subset Case. 

8. Select the format of your batch file: Document Entries or Page Range Entries. 
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Note: See the sample Subset Case Batch File for an explanation of each type of entry. 
 

 

9. If you want the items renumbered sequentially, enter the beginning number for the new naming 
convention (e.g., ABC001). 

• If you entered a beginning number for the new naming convention, decide whether to 
increment the number at each new document or each new page. 

• If you want to include revisions, make sure that the Include Page Builds option is selected . 

10. Click Export to create the subset case. 
 

 

If errors occur during the process, a message appears asking if you want to view the problems list. 

The problems list is saved in the original case folder. For example, if you create a subset case from 
the demonstration case (Case0000), the error file will be saved as Case0001.ERR (where Case0001 
is the subset case number) in the Case0000 folder. 

Possible problems include items that are listed more than once (two items cannot have the same 
Item ID) and items that are not found in the case. 

11. When the process is complete, a message appears telling you that the subset case has been 
created successfully. Click OK to complete the process. 
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You will now be able to open the subset case as you would any other case. 

When the subset case is created, a cross-reference file is created and stored in the original case folder. For 
example, if you create a subset case from the demonstration case (Case0000), the cross-reference file will 
be saved as Case0001.XRF (where Case0001 is the subset case number) in the Case0000 folder.  
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Finding Items 
You may want to locate items in your case using one of TrialDirector's searching tools. TrialDirector gives you 
three tools to search for items in the Case Explorer, Document Manager or Coding module: (1) the Quick 
Find tool, (2) the Find Dialog for more advanced tools, and (3) Clipboard Linking for external searches. (Click 
here to learn more about searching in Transcript Manager.)  

 Using the Quick Find Tool 

 Using the Find Dialog 

 Using Clipboard Linking 

Using the Quick Find Tool 

The Quick Find Tool lets you quickly conduct a simple search in the Case Explorer, Document Manager and 
Coding modules. You may conduct a more advanced search by using the Find Dialog on the main toolbar. 

The Quick Find Tool searches all text fields, including attached memos. (It does not search the file volume, 
file path, file name, and modify date fields in the Document Manager.)  

  

 

To Run a Quick Find 

1. Enter a term or phrase in the Quick Find box. 

2. Click the Launch Quick Find button. TrialDirector opens the first item returned as a result of the 
search. 

3. To find the next item, click the Launch Quick Find button again. 

To View the Quick Find Toolbar 

If the Quick Find tool doesn't appear on the Case Library, Document Manager or Coding module toolbar: 

1. Open the View menu. 
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2. Select Toolbars. 

3. Select Quick Find. 

Using the Find Dialog 

The Find Dialog gives you a tool to search the Item ID, Description, Exhibit Number, Trial Exhibit Number, 
Memos and OCR text associated with case items. 

1. Click the Find tool   on the main toolbar or open the Edit menu and select Find. 

 

2. Type the word or phrase you would like to search for in the Find What field.  
• You do not need to use a wildcard character. TrialDirector automatically searches for the 

root word and variations such as, for example, plurals. See the following examples: 
• To search for train, training, trainer, trainers and trains, you would enter train in the 

Find What field. 
• To find all Item IDs beginning with BK, enter BK in the Find What field. 

• The text is not case sensitive.  
• If you enter more than one word, TrialDirector assumes you are searching for a phrase with 

those words in the same order as entered. 

3. Select one of the following viewing options: 

 Select Browse Results Individually if you want to jump to each matching items 
one at a time when the Find First then Find Next button is clicked. 

 Select Send Results to Workbook if you want to display all matching records in 
the Search Results workbook.  

4. Check the boxes next to the fields you want to search.  

Note: The Admitted Fields search options are only available when the Admitted workbook is 
selected in the Workbooks Explorer. 

5. Click Find First. To find subsequent items matching the search, click Find Next. 
6. Click Cancel to close the Find dialog.  
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Using Clipboard Linking  

Most third-party document management systems can be used to locate documents in TrialDirector by 
copying query results to the Windows Clipboard. 

To illustrate the clipboard linking concept, the following example uses Windows Notepad in place of other 
Windows-based products you might use for this purpose. 

1. Open Windows Notepad by clicking the Windows Start | Run command and typing "notepad."  

2. Click OK to open the program. 

3. Resize and move the Notepad window so you can view both Notepad and Document Manager. 

4. Type the search text in Notepad. Keep in mind that a valid Item ID must be found within the first 
three words of the search text.  

5. Highlight the selected text and press Control + C (or open Notepad's Edit menu and select Copy) 
to copy the search text to the Windows Clipboard. TrialDirector automatically displays the 
referenced item.  
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Search and Replace 
The search and replace feature allows you to search a selected Case Explorer field for all occurrences of 
specified text and replace the text with alternative text. Follow these steps to find and replace text: 

1. Select Replace from the Edit menu. 

 

2. Type the text you want to find and replace in the Find What: field. 

3. Type the replacement text in the Replace With: field or leave it blank, as desired. 

4. Select the field to be searched by clicking on the arrow next to Select Field and selecting the desired 
field from the drop-down list. 

5. Select the Match Case option if you want the search to be case sensitive. 

6. Select the Find Whole Word Only option if you do not want the search to find any matches within a 
word (i.e., "exh" would not find "exhibit"). 

7. When the options are set as desired, click [Replace] to begin the process. When the process is 
complete, a small window will appear, indicating how many replacements were made. 

8. Click [OK] to return to the Search & Replace window. 

9. Click [Save Changes] to make the replacements permanent or [Cancel] to cancel without saving 
the changes.  
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